Installing ABAP Development Tools for Eclipse
# Content

<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>About This Installation Guide</td>
<td>4</td>
</tr>
<tr>
<td>2</td>
<td>Disclaimer</td>
<td>6</td>
</tr>
<tr>
<td>2.1</td>
<td>Eclipse Public License - v 1.0</td>
<td>7</td>
</tr>
<tr>
<td>2.2</td>
<td>Apache License Version 2.0</td>
<td>11</td>
</tr>
<tr>
<td>2.3</td>
<td>BSD Two Clause &quot;Simplified&quot; License</td>
<td>14</td>
</tr>
<tr>
<td>2.4</td>
<td>Documentation in the SAP Help Portal</td>
<td>15</td>
</tr>
<tr>
<td>3</td>
<td>Support and Maintenance Strategy</td>
<td>16</td>
</tr>
<tr>
<td>3.1</td>
<td>General Terms</td>
<td>16</td>
</tr>
<tr>
<td>3.2</td>
<td>Support Platform Matrix</td>
<td>17</td>
</tr>
<tr>
<td>3.3</td>
<td>Special Terms for Operating Systems</td>
<td>18</td>
</tr>
<tr>
<td>3.4</td>
<td>Special Terms for Java Runtime Versions</td>
<td>18</td>
</tr>
<tr>
<td>3.5</td>
<td>Special Terms for Eclipse Versions</td>
<td>19</td>
</tr>
<tr>
<td>3.6</td>
<td>Home Special Terms for SAP GUI Versions</td>
<td>19</td>
</tr>
<tr>
<td>3.7</td>
<td>Special Terms for Microsoft Visual C++ Runtime Versions</td>
<td>19</td>
</tr>
<tr>
<td>3.8</td>
<td>Special Terms for Browser Versions</td>
<td>20</td>
</tr>
<tr>
<td>3.9</td>
<td>Language Support</td>
<td>20</td>
</tr>
<tr>
<td>3.10</td>
<td>SAP Shipment Channel and License Agreement</td>
<td>20</td>
</tr>
<tr>
<td>4</td>
<td>Introduction</td>
<td>21</td>
</tr>
<tr>
<td>5</td>
<td>Home Preparation</td>
<td>22</td>
</tr>
<tr>
<td>5.1</td>
<td>Preparing the ABAP Back-End System</td>
<td>22</td>
</tr>
<tr>
<td>5.2</td>
<td>Establishing Secure Network Communication</td>
<td>22</td>
</tr>
<tr>
<td></td>
<td>Recommendation</td>
<td>23</td>
</tr>
<tr>
<td>6</td>
<td>Installation</td>
<td>24</td>
</tr>
<tr>
<td>6.1</td>
<td>Installing ABAP Development Tools</td>
<td>24</td>
</tr>
<tr>
<td></td>
<td>Prerequisites</td>
<td>24</td>
</tr>
<tr>
<td></td>
<td>Context</td>
<td>26</td>
</tr>
<tr>
<td></td>
<td>Installation Steps</td>
<td>27</td>
</tr>
<tr>
<td></td>
<td>Result</td>
<td>31</td>
</tr>
<tr>
<td>6.2</td>
<td>Updating ABAP Development Tools</td>
<td>32</td>
</tr>
<tr>
<td>6.3</td>
<td>Recommendations for the System Administrator</td>
<td>33</td>
</tr>
<tr>
<td></td>
<td>Manual Building of a Distributable Eclipse IDE Package</td>
<td>34</td>
</tr>
<tr>
<td></td>
<td>Automated Building of a Distributable Eclipse IDE Package</td>
<td>36</td>
</tr>
<tr>
<td></td>
<td>Updating an Already Distributed Eclipse IDE Package</td>
<td>43</td>
</tr>
</tbody>
</table>
7 Post-Installation ............................................................ 45
  7.1 [Optional] Home Configuring SAP GUI for Java .................... 45
  7.2 [Optional] Configuring VM Parameters .............................. 46
  7.3 [Optional] Configuring Accessibility Features of ADT ............ 48
8 De-Installation ............................................................. 49
9 Support Case .............................................................. 51
  9.1 Providing Additional Information for Analyzing an Error ........ 51
  9.2 Getting Support Information ........................................... 52
10 Additional Information ....................................................... 53
  10.1 Installing Plug-ins from Third Parties ............................... 53
  10.2 Sample Code for Building an Ant Script ............................ 53
1 About This Installation Guide

Scope of Documentation

This documentation describes how to install the Eclipse-based front-end components of ABAP development tools for Eclipse (in short: ADT) on a local drive.

Target Audience

• ABAP system administrators and developers who want to install, build, or provide the installation packages from ABAP development tools for Eclipse for ABAP developers who work with an Eclipse-based IDE.
• ABAP system administrators who configure the ABAP server for each back-end system in order to connect them with ABAP development tools for Eclipse.

Context

ABAP development tools for Eclipse provides features that are client-specific or require a specific back-end version. To highlight and contrast back-end-specific help content in the relevant context, the following SAP icon fonts are used:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Deployment Model</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Home</td>
<td>On-premise/Private Cloud</td>
<td>Used for SAP NetWeaver, SAP S/4HANA and for SAP S/4HANA Cloud, private edition</td>
</tr>
<tr>
<td>Cloud</td>
<td>Public Cloud</td>
<td>Used for SAP BTP ABAP environment and SAP S/4HANA Cloud</td>
</tr>
</tbody>
</table>

Validity of Documentation

This documentation belongs to ABAP development tools for Eclipse with the client version 3.40 and refers to the range of functions that have been shipped as part of the standard delivery for:

• Home On-premise/Private Cloud shipments:
  • SAP NetWeaver 7.3 EHP1 SP04 and higher
  • SAP NetWeaver 7.4 SP02 and higher
  • SAP NetWeaver 7.5 SP00 and higher
  • SAP NetWeaver AS for ABAP 7.51 innovation package SP00 and higher
  • SAP NetWeaver AS for ABAP 7.52 SP00 and higher
To enable development using ABAP development tools for Eclipse in releases ≥ SAP NetWeaver 7.3 EHP1 SP04 and ≥ SAP products based on ABAP platform 1909 (Application Server ABAP 7.54) the ABAP system administrator needs to configure each back-end first.

For more information, see the back-end configuration guide Configuring the ABAP Back-end for ABAP Development Tools for Eclipse
2 Disclaimer

Some components of this product are based on Java™. Any code change in these components may cause unpredictable and severe malfunctions and is therefore expressly prohibited, as is any decompilation of these components.

Any Java™ Source Code delivered with this product is only to be used by SAP’s Support Services and may not be modified or altered in any way.

This program contains the following third party open source or other free download components that are not part of the SAP software and not subject to your SAP license and/or maintenance agreement. The third party licensees of these components may provide additional license rights, terms and conditions and/or require certain notices as described below.

If you have any questions or concerns please contact: opensource@sap.com

<table>
<thead>
<tr>
<th>Third Party Component</th>
<th>License</th>
</tr>
</thead>
<tbody>
<tr>
<td>Eclipse Platform:</td>
<td></td>
</tr>
<tr>
<td>• 2023-12 (4.30)</td>
<td></td>
</tr>
<tr>
<td>• 2023-09 (4.29)</td>
<td></td>
</tr>
<tr>
<td>Eclipse Semantic File System (SFS) (SAP), 0.70.sap</td>
<td>Eclipse Public License v 1.0</td>
</tr>
<tr>
<td>Handy-URI-Templates, 1.1.7</td>
<td>Apache License 2.0</td>
</tr>
<tr>
<td>lz4 Compression algorithm, 1.8.1.2</td>
<td>BSD Two Clause “Simplified” License</td>
</tr>
<tr>
<td>spring-security-jwt, 1.1.1</td>
<td>Apache License 2.0</td>
</tr>
</tbody>
</table>

List of additional features required for running ABAP Development Tools

<table>
<thead>
<tr>
<th>Feature Name</th>
<th>Feature ID</th>
</tr>
</thead>
<tbody>
<tr>
<td>EMF Edit Data Binding</td>
<td>org.eclipse.emf.databinding.edit.feature.group</td>
</tr>
<tr>
<td>EMF Model Query</td>
<td>org.eclipse.emf.query.feature.group</td>
</tr>
<tr>
<td>EMF Model Transaction Workbench Integration</td>
<td>org.eclipse.emf.workspace.feature.group</td>
</tr>
<tr>
<td>EMF Validation Framework</td>
<td>org.eclipse.emf.validation.feature.group</td>
</tr>
<tr>
<td>Graphiti (Incubation)</td>
<td>org.eclipse.graphiti.feature.feature.group</td>
</tr>
<tr>
<td>Web Services Tools</td>
<td>org.eclipse.wst.ws_ui.feature.feature.group</td>
</tr>
<tr>
<td>GEF Classic Zest</td>
<td>org.eclipse.zest.feature.group</td>
</tr>
</tbody>
</table>
ABAP Development Tools (ADT) requires manual installation of the above mentioned additional Eclipse features before the ABAP Development Tools package installation due to the following reasons:

1. **Customer Requirement:** Many developers at customer and partner organizations do not have internet access or an official SAP Support Portal (S-) User. Thus, SAP decided to provide an installation scenario for a person who usually has an S User and internet access: that is, an administrator who is responsible for the development landscape in the customer or partner organization.

2. **One Central Reference Installation:** The additional manual steps are only required for one administrator who assembles a complete reference installation. SAP is responsible and will provide support and maintenance for the SAP features in this central reference installation.

3. **Several Decentralized Customer Installations:** The administrator can copy and extend the reference installation with more features and takes over the responsibility for this customer specific installation. The administrator will then provide this customer specific installation to many developers (without S User or internet access). Thus the majority of developers in the SAP customer and partner community will not have to perform the mentioned manual installation steps of some additional Eclipse features.

4. **Innovation:** SAP is able to support the current Eclipse release with this product at an earlier point in time than in the past.

5. **Transparency:** SAP customers and partners know exactly for which features SAP is responsible and for which SAP will provide support and maintenance. With an automatic installation of the required additional features, this would not be transparent.

### 2.1 Eclipse Public License - v 1.0

THE ACCOMPANYING PROGRAM IS PROVIDED UNDER THE TERMS OF THIS ECLIPSE PUBLIC LICENSE (“AGREEMENT”). ANY USE, REPRODUCTION OR DISTRIBUTION OF THE PROGRAM CONSTITUTES THE RECIPIENT’S ACCEPTANCE OF THIS AGREEMENT.

#### 1. DEFINITIONS

"Contribution" means:

a) In the case of the initial Contributor, the initial code and documentation distributed under this Agreement, and

b) In the case of each subsequent Contributor:

i) Changes to the Program, and

ii) Additions to the Program;

where such changes and/or additions to the Program originate from and are distributed by that particular Contributor. A Contribution ‘originates’ from a Contributor if it was added to the Program by such Contributor itself or anyone acting on such Contributor’s behalf. Contributions do not include additions to the Program which: (i) are separate modules of software distributed in conjunction with the Program under their own license agreement, and (ii) are not derivative works of the Program.

"Contributor" means any person or entity that distributes the Program.
"Licensed Patents" mean patent claims licensable by a Contributor that are necessarily infringed by the use or sale of its Contribution alone or when combined with the Program.

"Program" means the Contributions distributed in accordance with this Agreement.

"Recipient" means anyone who receives the Program under this Agreement, including all Contributors.

2. GRANT OF RIGHTS

a) Subject to the terms of this Agreement, each Contributor hereby grants the Recipient a non-exclusive, worldwide, royalty-free copyright license to reproduce, prepare derivative works of, publicly display, publicly perform, distribute and sublicense the Contribution of such Contributor, if any, and such derivative works, in source code and object code form.

b) Subject to the terms of this Agreement, each Contributor hereby grants Recipient a non-exclusive, worldwide, royalty-free patent license under Licensed Patents to make, use, sell, offer to sell, import and otherwise transfer the Contribution of such Contributor, if any, in source code and object code form. This patent license shall apply to the combination of the Contribution and the Program if, at the time the Contribution is added by the Contributor, such addition of the Contribution causes such combination to be covered by the Licensed Patents. The patent license shall not apply to any other combinations which include the Contribution. No hardware per se is licensed hereunder.

c) The recipient understands that although each Contributor grants the licenses to its Contributions set forth herein, no assurances are provided by any Contributor that the Program does not infringe the patent or other intellectual property rights of any other entity. Each Contributor disclaims any liability to Recipient for claims brought by any other entity based on infringement of intellectual property rights or otherwise. As a condition to exercising the rights and licenses granted hereunder, each Recipient hereby assumes sole responsibility to secure any other intellectual property rights needed, if any. For example, if a third party patent license is required to allow Recipient to distribute the Program, it is Recipient’s responsibility to acquire that license before distributing the Program.

d) Each Contributor represents that to its knowledge it has sufficient copyright rights in its Contribution, if any, to grant the copyright license set forth in this Agreement.

3. REQUIREMENTS

A Contributor may choose to distribute the Program in object code form under its own license agreement, provided that:

a) it complies with the terms and conditions of this Agreement; and

b) its license agreement:

i) effectively disclaims on behalf of all Contributors all warranties and conditions, express and implied, including warranties or conditions of title and non-infringement, and implied warranties or conditions of merchantability and fitness for a particular purpose;

ii) effectively excludes on behalf of all Contributors all liability for damages, including direct, indirect, special, incidental and consequential damages, such as lost profits;
iii) states that any provisions which differ from this Agreement are offered by that Contributor alone and not by any other party; and

iv) states that source code for the Program is available from such Contributor, and informs licensees how to obtain it in a reasonable manner on or through a medium customarily used for software exchange. When the Program is made available in source code form:

a) it must be made available under this Agreement; and

b) a copy of this Agreement must be included with each copy of the Program.

Contributors may not remove or alter any copyright notices contained within the Program.

Each Contributor must identify itself as the originator of its Contribution, if any, in a manner that reasonably allows subsequent Recipients to identify the originator of the Contribution.

4. COMMERCIAL DISTRIBUTION

Commercial distributors of software may accept certain responsibilities with respect to end users, business partners and the like. While this license is intended to facilitate the commercial use of the Program, the Contributor who includes the Program in a commercial product offering should do so in a manner which does not create potential liability for other Contributors. Therefore, if a Contributor includes the Program in a commercial product offering, such Contributor (“Commercial Contributor”) hereby agrees to defend and indemnify every other Contributor (“Indemnified Contributor”) against any losses, damages and costs (collectively “Losses”) arising from claims, lawsuits and other legal actions brought by a third party against the Indemnified Contributor to the extent caused by the acts or omissions of such Commercial Contributor in connection with its distribution of the Program in a commercial product offering. The obligations in this section do not apply to any claims or Losses relating to any actual or alleged intellectual property infringement. In order to qualify, an Indemnified Contributor must: a) promptly notify the Commercial Contributor in writing of such claim, and b) allow the Commercial Contributor to control, and cooperate with the Commercial Contributor in, the defense and any related settlement negotiations. The Indemnified Contributor may participate in any such claim at its own expense.

For example, a Contributor might include the Program in a commercial product offering, Product X. That Contributor is then a Commercial Contributor. If that Commercial Contributor then makes performance claims, or offers warranties related to Product X, those performance claims and warranties are such Commercial Contributor’s responsibility alone. Under this section, the Commercial Contributor would have to defend claims against the other Contributors related to those performance claims and warranties, and if a court requires any other Contributor to pay any damages as a result, the Commercial Contributor must pay those damages.

5. NO WARRANTY

EXCEPT WHERE EXPRESSLY SET FORTH IN THIS AGREEMENT, THE PROGRAM IS PROVIDED ON AN "AS IS" BASIS, WITHOUT WARRANTIES OR CONDITIONS OF ANY KIND, EITHER EXPRESS OR IMPLIED INCLUDING, WITHOUT LIMITATION, ANY WARRANTIES OR CONDITIONS OF TITLE, NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Each Recipient is solely responsible for determining the appropriateness of using and distributing the Program and assumes all risks associated with its exercise of rights under this Agreement, including but not limited to the risks and costs of program errors,
compliance with applicable laws, damage to or loss of data, programs or equipment, and unavailability or interruption of operations.

6. DISCLAIMER OF LIABILITY

EXCEPT WHERE EXPRESSLY SET FORTH IN THIS AGREEMENT, NEITHER RECIPIENT NOR ANY CONTRIBUTORS SHALL HAVE ANY LIABILITY FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING WITHOUT LIMITATION LOST PROFITS), HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OR DISTRIBUTION OF THE PROGRAM OR THE EXERCISE OF ANY RIGHTS GRANTED HEREUNDER, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

7. GENERAL

If any provision of this Agreement is invalid or unenforceable under applicable law, it shall not affect the validity or enforceability of the remainder of the terms of this Agreement, and without further action by the parties hereto, such provision shall be reformed to the minimum extent necessary to make such provision valid and enforceable.

If Recipient institutes patent litigation against any entity (including a cross-claim or counterclaim in a lawsuit) alleging that the Program itself (excluding combinations of the Program with other software or hardware) infringes such Recipient’s patent(s), then such Recipient’s rights granted under Section 2(b) shall terminate as of the date such litigation is filed.

All Recipient’s rights under this Agreement shall terminate if it fails to comply with any of the material terms or conditions of this Agreement and does not cure such failure in a reasonable period of time after becoming aware of such noncompliance. If all Recipients’ rights under this Agreement terminate, Recipient agrees to cease use and distribution of the Program as soon as reasonably practicable. However, Recipient’s obligations under this Agreement and any licenses granted by Recipient relating to the Program shall continue and survive.

Everyone is permitted to copy and distribute copies of this Agreement, but in order to avoid inconsistency the Agreement is copyrighted and may only be modified in the following manner. The Agreement Steward reserves the right to publish new versions (including revisions) of this Agreement from time to time. No one other than the Agreement Steward has the right to modify this Agreement. The Eclipse Foundation is the initial Agreement Steward. The Eclipse Foundation may assign the responsibility to serve as the Agreement Steward to a suitable separate entity. Each new version of the Agreement will be given a distinguishing version number. The Program (including Contributions) may always be distributed subject to the version of the Agreement under which it was received. In addition, after a new version of the Agreement is published, Contributor may elect to distribute the Program (including its Contributions) under the new version. Except as expressly stated in Sections 2(a) and 2(b) above, Recipient receives no rights or licenses to the intellectual property of any Contributor under this Agreement, whether expressly, by implication, estoppel or otherwise. All rights in the Program not expressly granted under this Agreement are reserved.

This Agreement is governed by the laws of the State of New York and the intellectual property laws of the United States of America. No party to this Agreement will bring a legal action under this Agreement more than one year after the cause of action arose. Each party waives its rights to a jury trial in any resulting litigation.
2.2 Apache License Version 2.0

January 2004

http://www.apache.org/licenses/

TERMS AND CONDITIONS FOR USE, REPRODUCTION, AND DISTRIBUTION

1. Definitions

"License" shall mean the terms and conditions for use, reproduction, and distribution as defined by Sections 1 through 9 of this document.

"Licensor" shall mean the copyright owner or entity authorized by the copyright owner that is granting the License.

"Legal Entity" shall mean the union of the acting entity and all other entities that control, are controlled by, or are under common control with that entity. For the purposes of this definition, "control" means (i) the power, direct or indirect, to cause the direction or management of such entity, whether by contract or otherwise, or (ii) ownership of fifty percent (50%) or more of the outstanding shares, or (iii) beneficial ownership of such entity.

"You" (or "Your") shall mean an individual or Legal Entity exercising permissions granted by this License.

"Source" form shall mean the preferred form for making modifications, including but not limited to software source code, documentation source, and configuration files.

"Object" form shall mean any form resulting from mechanical transformation or translation of a Source form, including but not limited to compiled object code, generated documentation, and conversions to other media types.

"Work" shall mean the work of authorship, whether in Source or Object form, made available under the License, as indicated by a copyright notice that is included in or attached to the work (an example is provided in the Appendix below).

"Derivative Works" shall mean any work, whether in Source or Object form, that is based on (or derived from) the Work and for which the editorial revisions, annotations, elaborations, or other modifications represent, as a whole, an original work of authorship. For the purposes of this License, Derivative Works shall not include works that remain separable from, or merely link (or bind by name) to the interfaces of, the Work and Derivative Works thereof.

"Contribution" shall mean any work of authorship, including the original version of the Work and any modifications or additions to that Work or Derivative Works thereof, that is intentionally submitted to Licensor for inclusion in the Work by the copyright owner or by an individual or Legal Entity authorized to submit on behalf of the copyright owner. For the purposes of this definition, "submitted" means any form of electronic, verbal, or written communication sent to the Licensor or its representatives, including but not limited to communication on electronic mailing lists, source code control systems, and issue tracking systems that are managed by, or on behalf of, the Licensor for the purpose of discussing and improving the Work, but excluding communication that is conspicuously marked or otherwise designated in writing by the copyright owner as "Not a Contribution."

"Contributor" shall mean Licensor and any individual or Legal Entity on behalf of whom a Contribution has been received by Licensor and subsequently incorporated within the Work.
2. Grant of Copyright License

Subject to the terms and conditions of this License, each Contributor hereby grants to You a perpetual, worldwide, non-exclusive, no-charge, royalty-free, irrevocable copyright license to reproduce, prepare Derivative Works of, publicly display, publicly perform, sublicense, and distribute the Work and such Derivative Works in Source or Object form.

3. Grant of Patent License

Subject to the terms and conditions of this License, each Contributor hereby grants to You a perpetual, worldwide, non-exclusive, no-charge, royalty-free, irrevocable (except as stated in this section) patent license to make, have made, use, offer to sell, sell, import, and otherwise transfer the Work, where such license applies only to those patent claims licensable by such Contributor that are necessarily infringed by their Contribution(s) alone or by combination of their Contribution(s) with the Work to which such Contribution(s) was submitted. If You institute patent litigation against any entity (including a cross-claim or counterclaim in a lawsuit) alleging that the Work or a Contribution incorporated within the Work constitutes direct or contributory patent infringement, then any patent licenses granted to You under this License for that Work shall terminate as of the date such litigation is filed.

4. Redistribution

You may reproduce and distribute copies of the Work or Derivative Works thereof in any medium, with or without modifications, and in Source or Object form, provided that You meet the following conditions:

1. You must give any other recipients of the Work or Derivative Works a copy of this License; and
2. You must cause any modified files to carry prominent notices stating that You changed the files; and
3. You must retain, in the Source form of any Derivative Works that You distribute, all copyright, patent, trademark, and attribution notices from the Source form of the Work, excluding those notices that do not pertain to any part of the Derivative Works; and
4. If the Work includes a "NOTICE" text file as part of its distribution, then any Derivative Works that You distribute must include a readable copy of the attribution notices contained within such NOTICE file, excluding those notices that do not pertain to any part of the Derivative Works, in at least one of the following places: within a NOTICE text file distributed as part of the Derivative Works; within the Source form or documentation, if provided along with the Derivative Works; or, within a display generated by the Derivative Works, if and wherever such third-party notices normally appear. The contents of the NOTICE file are for informational purposes only and do not modify the License. You may add your own attribution notices within Derivative Works that You distribute, alongside or as an addendum to the NOTICE text from the Work, provided that such additional attribution notices cannot be construed as modifying the License.

You may add your own copyright statement to Your modifications and may provide additional or different license terms and conditions for use, reproduction, or distribution of Your modifications, or for any such Derivative Works as a whole, provided Your use, reproduction, and distribution of the Work otherwise complies with the conditions stated in this License.
5. Submission of Contributions

Unless you explicitly state otherwise, any Contribution intentionally submitted for inclusion in the Work by you to the Licensor shall be under the terms and conditions of this License, without any additional terms or conditions. Notwithstanding the above, nothing herein shall supersede or modify the terms of any separate license agreement you may have executed with Licensor regarding such Contributions.

6. Trademarks

This License does not grant permission to use the trade names, trademarks, service marks, or product names of the Licensor, except as required for reasonable and customary use in describing the origin of the Work and reproducing the content of the NOTICE file.

7. Disclaimer of Warranty

Unless required by applicable law or agreed to in writing, Licensor provides the Work (and each Contributor provides its Contributions) on an "AS IS" BASIS, WITHOUT WARRANTIES OR CONDITIONS OF ANY KIND, either express or implied, including, without limitation, any warranties or conditions of TITLE, NONINFRINGEMENT, MERCHANTABILITY, or FITNESS FOR A PARTICULAR PURPOSE. You are solely responsible for determining the appropriateness of using or redistributing the Work and assume any risks associated with your exercise of permissions under this License.

8. Limitation of Liability

In no event and under no legal theory, whether in tort (including negligence), contract, or otherwise, unless required by applicable law (such as deliberate and grossly negligent acts) or agreed to in writing, shall any Contributor be liable to You for damages, including any direct, indirect, special, incidental, or consequential damages of any character arising as a result of this License or out of the use or inability to use the Work (including but not limited to damages for loss of goodwill, work stoppage, computer failure or malfunction, or any and all other commercial damages or losses), even if such Contributor has been advised of the possibility of such damages.

9. Accepting Warranty or Additional Liability

While redistributing the Work or Derivative Works thereof, You may choose to offer, and charge a fee for, acceptance of support, warranty, indemnity, or other liability obligations and/or rights consistent with this License. However, in accepting such obligations, You may act only on Your own behalf and on Your sole responsibility, not on behalf of any other Contributor, and only if You agree to indemnify, defend, and hold each Contributor harmless for any liability incurred by, or claims asserted against, such Contributor by reason of your accepting any such warranty or additional liability.
APPENDIX: How to apply the Apache License to your work

To apply the Apache License to your work, attach the following boilerplate notice, with the fields enclosed by brackets "[]" replaced with your own identifying information. (Don’t include the brackets!) The text should be enclosed in the appropriate comment syntax for the file format. We also recommend that a file or class name and description of purpose be included on the same “printed page” as the copyright notice for easier identification within third-party archives.

Copyright [yyyy] [name of copyright owner]

Licensed under the Apache License, Version 2.0 (the "License");

You may not use this file except in compliance with the License.

You may obtain a copy of the License at

http://www.apache.org/licenses/LICENSE-2.0

Unless required by applicable law or agreed to in writing, software distributed under the License is distributed on an "AS IS" BASIS, WITHOUT WARRANTIES OR CONDITIONS OF ANY KIND, either express or implied. See the License for the specific language governing permissions and limitations under the License.

2.3 BSD Two Clause "Simplified" License

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.
2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution.

THIS SOFTWARE IS PROVIDED BY THE AUTHOR "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE AUTHOR BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
2.4 Documentation in the SAP Help Portal

You can find this documentation at the Product Finder on the SAP Help Portal in the Technology Platform area.
3 Support and Maintenance Strategy

ABAP Development Tools (ADT) include a server and a client part. For both the Support and Maintenance Strategy is different from SAP NetWeaver 7.3 EHP1. As SAP GUI the ABAP Development Tools follow the SAP Maintenance Strategy Rule 11: “Downward-compatible software component versions can be replaced by a higher version in the course of the life of the application release they are built into, without adaptations or changes to other software component versions within the release. Therefore downward-compatible software component versions are usually not maintained for the entire mainstream and extended maintenance period of the application release they are built into. Instead they have to be replaced by a higher version.”

ABAP Development Tools is a Downward-Compatible Software Component Version. This means that starting with SAP NetWeaver 7.3 EHP1 the most current client version of the ABAP Development Tools will always be compatible with all future SAP NetWeaver 7.3 EHP1, ABAP platform 1809 (AS ABAP 7.53) and higher, as well as SAP BTP ABAP environment shipments. But this requires the users to regularly update to the current client version of the ABAP Development Tools. Because the client has many dependencies this may require additional updates on the PC which will be listed in the following client section.

<table>
<thead>
<tr>
<th>Note</th>
<th>For more information, see <a href="https://me.sap.com/notes/">https://me.sap.com/notes/</a> ABAP Development Tools support strategy</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cloud</td>
<td>SAP GUI is not relevant in the context of SAP BTP ABAP environment.</td>
</tr>
</tbody>
</table>

3.1 General Terms

ABAP Development Tools (ADT) depends on Eclipse and SAP GUI. It will not be shipped as a bundle with Eclipse and SAP GUI but separately as an Eclipse p2 repository. Both Eclipse and SAP GUI are supported for different individual platforms. The support of individual platforms also depends on the support of the operating systems by the manufacturers. SAP cannot provide support for a platform or for an operating system that is no longer supported by its vendor or manufacturer. By the same token, SAP cannot provide support for an Eclipse version or any other Open Source software version that is no longer supported by the Eclipse Foundation or the Open Source community.

| Note | Cloud SAP GUI is not relevant in the context of SAP BTP ABAP environment. |
### 3.2 Support Platform Matrix

ABAP development tools for Eclipse is only supported for a subset of the individual platform and operating system versions for which Eclipse and SAP GUI are supported. These are:

<table>
<thead>
<tr>
<th>Software</th>
<th>Version</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating System</td>
<td>• Microsoft Windows 10™ or higher</td>
</tr>
<tr>
<td></td>
<td>• Apple macOS 10.15 or higher</td>
</tr>
<tr>
<td>Java Runtime</td>
<td>JRE version 17 or 21 (64-Bit, LTS)</td>
</tr>
</tbody>
</table>

**Note**
- ADT is validated and tested against Java versions 17 and 21 (Oracle Java and OpenJDK).
- The latest Eclipse packages are bundled with Eclipse Temurin, an OpenJDK binary distribution provided by the Eclipse Adoptium project. Any other JRE found on the system is not used. If you want to remove the bundled JRE and use a custom one, see SAP note 3035242.

| Microsoft Visual C++ Runtime | Visual Studio 2013 (Visual C++ 12.0)         |

**Note**
- SAP GUI is not relevant in the context of SAP BTP ABAP environment.

| SAP GUI for Windows          | 7.60 or higher                               |
3.3 Special Terms for Operating Systems

SAP recommends that you always use a current Support Package for the relevant operating system listed in the ABAP Development Tools. An operating system that is no longer supported by its manufacturer should no longer be used in conjunction with ABAP Development Tools. If an issue occurs only on an unsupported operating system SAP will not analyze nor solve the issue, but instead reply by recommending an operating system upgrade. Additionally SAP does not test ABAP Development Tools on such operating systems anymore.

3.4 Special Terms for Java Runtime Versions

SAP recommends that you always use a current Java runtime version listed in the ABAP Development Tools. A Java runtime version that is no longer supported by the Java runtime version manufacturer should no longer be used in conjunction with ABAP Development Tools. If an issue occurs only on an unsupported Java runtime version SAP will not analyze or solve the issue, but instead reply by recommending a Java runtime version upgrade. Additionally SAP does not test ABAP Development Tools on such Java runtime versions anymore.
3.5 Special Terms for Eclipse Versions

SAP recommends that you always use a current Eclipse version listed in the ABAP Development Tools. An Eclipse version that is no longer supported by the Eclipse foundation should no longer be used in conjunction with ABAP Development Tools. If an issue occurs only on an unsupported Eclipse version SAP will not analyze or solve the issue, but instead reply by recommending an Eclipse version upgrade. Additionally SAP does not test ABAP Development Tools on such Eclipse versions anymore.

3.6 Home Special Terms for SAP GUI Versions

SAP recommends that you always use a current SAP GUI version listed in the ABAP Development Tools. A SAP GUI version that is no longer supported by SAP should no longer be used in conjunction with ABAP Development Tools. If an issue occurs only on an unsupported SAP GUI version SAP will not analyze or solve the issue, but instead reply by recommending a SAP GUI version upgrade. Additionally SAP does not test ABAP Development Tools on such SAP GUI versions anymore.

i Note

△ Cloud SAP GUI is not relevant in the context of SAP BTP ABAP environment.

3.7 Special Terms for Microsoft Visual C++ Runtime Versions

A Microsoft Visual C++ runtime version that is no longer supported by Microsoft should no longer be used in conjunction with ABAP Development Tools.

If an issue occurs only on an unsupported Microsoft VC runtime version SAP will not analyze or solve the issue, but instead reply by recommending a Microsoft VC runtime version upgrade.

i Note

SAP does not test ABAP Development Tools on such Microsoft VC runtime versions anymore.

→ Recommendation

SAP recommends that you always use a current Microsoft VC runtime version. For more information, see Prerequisites [page 24]
3.8 Special Terms for Browser Versions

SAP recommends that you always use a current browser version listed in the ABAP Development Tools. A browser version that is no longer supported by the browser manufacturer should no longer be used in conjunction with ABAP Development Tools. If an issue occurs only on an unsupported browser version SAP will not analyze or solve the issue, but instead reply by recommending a browser version upgrade. Additionally SAP does not test ABAP Development Tools on such browser versions anymore.

3.9 Language Support

SAP does not explicitly release different language versions of ABAP Development Tools other than English.

3.10 SAP Shipment Channel and License Agreement

The use of ABAP Development Tools (ADT) is subject to the terms and conditions of your license agreement with SAP which is directly related to the SAP shipment channel where ABAP Development Tools has been initially been downloaded and installed from. SAP does not support to update ABAP Development Tools with software from a different SAP shipment channel than the initial installation of ABAP Development Tools has been done.

example

An update of an older ABAP Development Tools installation which has originally been downloaded and installed from the SAP Support Portal with a newer ABAP Development Tools version which is provided on the SAP Developer Center is not recommended and not supported by SAP.
4 Introduction

ABAP Development Tools (ADT) is the integrated ABAP development environment built on top of the Eclipse platform.

Its main objective is to support developers in today’s increasingly complex development environments by offering state-of-the-art ABAP development tools.

These tools include strong and proven ABAP lifecycle management on the open Eclipse platform with powerful UI (user interface) capabilities.
5 Preparation

The preparation prior to the installation of front-end components includes all steps that you must perform in order to work smoothly with ABAP Development Tools on the ABAP back-end system. It includes the completion of the subsequent activities for each back-end system you want to work with and the establishing of the Secure Network Communication (SNC).

5.1 Preparing the ABAP Back-End System

In the context of on-premise scenarios, each back-end system you want to work with ADT, the ABAP system administrator needs to configure the corresponding ABAP systems first.

For this, the Configuration Guide for Configuring the ABAP Back-end for ABAP Development Tools is provided where you can find further information.

5.2 Establishing Secure Network Communication

Prerequisites

For security reasons, however, you must ensure that the Secure Network Communication (SNC) is implemented for the corresponding system and enabled for the selected system connection.

Context

In ABAP Development Tools, developers always work with ABAP projects to access repository objects from back-end systems. An ABAP project represents a real system connection on the front-end client and, therefore, it requires an authorized user to access the back-end system. With the standard authentication method, the user enters his or her user ID and password at the front-end client to log on to the back-end system.

Procedure

To enable SNC for an ABAP system, proceed as follows:
1. Add the relevant ABAP system to the SAP Logon Pad – if not already done.
2. In the SAP Logon Pad, open the Properties page for the ABAP system.
3. Enable the Secure Network Communication for the selected system – if not already done.

5.2.1 Recommendation

Context

For the sake of convenience, and again for security reasons, use also the single sign-on (SSO) option for system authentication (if it is available in your SAP NetWeaver system landscape). Compared with SNC, SSO meets the security requirements for working with ABAP projects even more. Using SSO, the user does not need to enter a user ID and password, but can access the specific system directly after the system has checked the validity of the logon ticket.

Procedure

To enable SSO for an ABAP system, proceed as follows:

1. Install the SAP NetWeaver Single Sign-On 1.0 SP03 or higher (either Secure LoginClient or Enterprise Single Sign-On) for the corresponding platform (64-Bit).
2. Configure the Secure Network Communication (SNC) between ABAP Development Tools and the ABAP back-end system.

For more information, see SAP Single Sign-On Community.
6 Installation

The subsequent installation procedure comprises all front-end components (SAP and Eclipse IDE packages) that are required to run ABAP Development Tools (ADT) on your local drive.

6.1 Installing ABAP Development Tools

6.1.1 Prerequisites

Operating System

The following operating system (OS) is installed on your local PC:

- Microsoft Windows™ 10 or higher
- Apple macOS 10.15 or higher

Java Runtime Environment (JRE)

One of the following JRE versions is installed:

JRE version 17 or 21 (64-Bit, LTS)

i Note

- ADT is validated and tested against Java versions 17 and 21 (Oracle Java and OpenJDK).
- The latest Eclipse packages are bundled with Eclipse Temurin, an OpenJDK binary distribution provided by the Eclipse Adoptium project. Any other JRE found on the system is not used. If you want to remove the bundled JRE and use a custom one, see SAP note 3035242.

Eclipse

You have already installed a suitable Eclipse IDE package based on one of the following releases:

- 2023-12 (4.30)
- 2023-09 (4.29)
Note
Technically any Eclipse IDE package with feature org.eclipse.platform of the corresponding release is installed, as a minimum, on your local drive.

SAP Software and SAP Support Portal Access
- **Home** For Windows™, SAP GUI for Windows 7.60 or higher, is installed on your local drive
  For Apple macOS, SAP GUI for Java 7.70 or higher, is installed on your local drive

Note
If this is not the case, install the SAP GUI\(^1\) first from the SAP Software Download Center on the SAP Support Portal.
You will need this SAP GUI\(^1\) for integration of GUI-based tools in the IDE for ABAP development.

Cloud SAP GUI is not relevant in the context of SAP BTP ABAP environment.

- You have an S User that enables to download the ABAP Development Tools package from the SAP Support Portal.

Required Eclipse Features
To benefit from all ADT features, you need to install the following additional Eclipse features in accordance to the relevant installation:

<table>
<thead>
<tr>
<th>Feature Name</th>
<th>Feature ID</th>
<th>SAP HANA Studio</th>
<th>Eclipse IDE for Java Developers</th>
</tr>
</thead>
<tbody>
<tr>
<td>EMF Edit Data Binding</td>
<td>org.eclipse.emf.databinding.edit.feature.group</td>
<td>✗</td>
<td>X</td>
</tr>
<tr>
<td>EMF Model Query</td>
<td>org.eclipse.emf.query.feature.group</td>
<td>✗</td>
<td>X</td>
</tr>
<tr>
<td>EMF Model Transaction Workbench</td>
<td>org.eclipse.emf.workspace.feature.group</td>
<td>✗</td>
<td>X</td>
</tr>
<tr>
<td>EMF Validation Framework</td>
<td>org.eclipse.emf.validation.feature.group</td>
<td>✗</td>
<td>X</td>
</tr>
<tr>
<td>Graphiti (Incubation)</td>
<td>org.eclipse.graphiti.feature.group</td>
<td>✗</td>
<td>X</td>
</tr>
<tr>
<td>Web Services Tools</td>
<td>org.eclipse.wst.ws_ui.feature.group</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>GEF Classic Zest</td>
<td>org.eclipse.zest.feature.group</td>
<td>✗</td>
<td>X</td>
</tr>
</tbody>
</table>

Note
If required Eclipse features are not displayed, it might be that they are already installed.
• To display all available features, deselect the *Hide items that are already installed* checkbox.  
• To check what is already installed, choose the *What is already installed?* link beside the checkbox from above.

### Internet Browser

On your local drive, one of the following browsers is installed:

• Chromium-based Browser  
• Firefox  
• Microsoft Edge  
• Safari

### Microsoft Components for Windows™

*Microsoft Visual C++ Redistributable Packages for Visual Studio 2013* (64 bit) is installed on your local drive.

<table>
<thead>
<tr>
<th>i Note</th>
</tr>
</thead>
</table>
| • You need this component for communication with the back-end system.  
• You need to install the runtime component separately from the Microsoft installation page.  
• If you start ADT before you have installed the DLLs, an error dialog might be opened stating that the ABAP communication layer is configured incorrectly. In this case, you need to restart Eclipse once with the "-clean" option. Afterwards, remove the "-clean" option again. For further information, see here [The Eclipse runtime options](#) |

### 6.1.2 Context

The ABAP Development Tools package is available for download in the [SAP Software Download Center](#) on the SAP Support Portal.

### 6.1.2.1 Use Cases

The subsequent installation of SAP components requires that you already have a suitable Eclipse IDE package in operation on your computer.

Depending on your use cases, you might need different Eclipse IDE packages:
• **ABAP development only**: For this use case, you only need the minimum Eclipse IDE package - for example, the Platform Runtime Binary - from the Eclipse download page.

• **Side-by-side Java and ABAP development**: For this use case, you usually already have an Eclipse IDE running. Here you can add the ABAP Development Tools features.

• **ABAP development on SAP HANA**: For this use case, you have already installed the latest SAP HANA Studio version on your local drive.

  **i Note**

  This use case is not relevant in the context of SAP BTP ABAP environment.

### 6.1.3 Installation Steps

#### Procedure

1. **Downloading the ABAP Development Tools package from the SAP Support Portal**:
   a. Launch the [SAP Software Download Center](https://support.sap.com/downloadcenter) on the SAP Support Portal.
   b. In the **Search Term** input field, enter `ABAP in Eclipse` for the name of the ADT package.
   c. In the **Search Results** view, choose the package with the highest version.
   d. Add the package to the download basket.
   e. Download the archive zip file to the local directory of your choice.

2. **Installing additional Eclipse features that are required for running ABAP Development Tools**:
   a. Launch the Eclipse IDE or SAP HANA Studio (see Prerequisites [page 24] above) that is installed on your local drive.
   b. Choose the menu `Help ➔ Install New Software...` to start the installation wizard.
   c. In the **Work with** field of the wizard, choose the package with the highest version from the list.
   d. For convenient selection, deselect the **Group items by category** checkbox on the wizard page.
Manual installation of a required feature provided by the latest Eclipse update site

e. Install the relevant Eclipse features – depending whether you are going to install ABAP Development Tools on top of SAP HANA Studio or not.

i. Note
   For more information about the required Eclipse features, see Prerequisites [page 24]
   Ensure that the filter box is empty.
   If you cannot find a required Eclipse feature, it might be already installed. To check this, deselect the Hide items that are already installed checkbox.

f. When you have finished marking your selections, ensure first the filter box is empty and then choose Next.

g. On the next wizard page, review the list of features to be installed and choose Next.

h. After you have accepted the terms of license agreement, initiate the installation of the selected features with Finish.

i. To apply the changes, restart the Eclipse IDE using the corresponding button in the information dialog that appears.
3. Installing the ABAP Development Tools package:
   a. Launch the installation wizard again through the menu Help > Install New Software…
   b. In the Work with field of the wizard, now specify the target directory where you downloaded the package using ABAP Development Tools.

   **Tip**
   To add the new installation directory, click the Add... Archive... button to specify the location and enter a name for your local software site. As highlighted in the screenshot below make sure the location path starts with "jar:file:/" and ends with "!/".

   ![Add Site](image)

   A software site that is located in the local file directory is specified by: jar:file:/<drive>/
   <directory_with_zipped_content>!/.

c. For convenient selection, check the Group items by category field on the Wizard page.
d. Select the relevant ABAP Development Tools item(s) and choose Next.

   **Note**
   The ABAP Core Development Tools are the mandatory installation whereas installation of other tools is optional. Select optional tools based on your requirements.
   
   In the context of SAP BTP ABAP environment, only the ABAP Core Development Tools is required.
e. On the next page, review the feature groups to be installed and choose Next again.
List of SAP feature groups to be installed

<table>
<thead>
<tr>
<th>Name</th>
<th>Id</th>
</tr>
</thead>
<tbody>
<tr>
<td>ABAP Connectivity And Integration Development Tools</td>
<td>com.sap.adt.pitif.feature.group</td>
</tr>
<tr>
<td>ABAP Core Development Tools</td>
<td>com.sap.adt.core.feature.group</td>
</tr>
<tr>
<td>ABAP Communication Framework</td>
<td>com.sap.adt.fwcl.feature.group</td>
</tr>
<tr>
<td>ABAP Development Tools Connectivity</td>
<td>com.sap.adt.connectivity.feature.group</td>
</tr>
<tr>
<td>ABAP Development Tools Foundation</td>
<td>com.sap.adt.tools.feature.group</td>
</tr>
<tr>
<td>ABAP Development Tools Notifications UI</td>
<td>com.sap.adt.notifications.feature.group</td>
</tr>
<tr>
<td>ABAP Transport Management</td>
<td>com.sap.adt.tm.feature.group</td>
</tr>
<tr>
<td>SAP Support Tools</td>
<td>com.sap.idc.support.feature.group</td>
</tr>
<tr>
<td>ABAP Development Tools for SAP HANA</td>
<td>com.sap.adt.tools.hana.feature.group</td>
</tr>
<tr>
<td>Web Dynpro ABAP Tools</td>
<td>com.sap.adt.wda.core.feature.group</td>
</tr>
</tbody>
</table>

**Note**

In case one or more of the required Eclipse features are missing, the *Install Remediation Page* is displayed with a warning that the installation cannot be completed. In this case, check and ensure that you have installed all required Eclipse features.

f. After you have accepted the terms of the license agreement, initiate the installation of selected SAP feature groups with **Finish**.

g. To apply the changes of the installation procedure, restart the Eclipse IDE.

### 6.1.4 Result

The successful installation procedure provides you with a ready-to-use ADT installation inside an Eclipse IDE package. It contributes the **ABAP** perspective to the Eclipse IDE.

The *Welcome* page (Help > Welcome) provides central access to knowledge material and provides links to related **ABAP Development User Guide** topics.
6.2 Updating ABAP Development Tools

Context

If you want to update an existing version of ABAP Development Tools, open the SAP Software Download Center on the SAP Support Portal. Here you will always find the most current version as an archive file.

i Note

If you want to add new functionality like "ABAP Enterprise Services and Integration Development Tools" or "ABAP Development Tools for Web Dynpro", you have to install these features by processing the installation steps from chapter Installing ABAP Development Tools [page 24].
Procedure

1. Download the new version of the ABAP Development Tools package from the SAP Support Portal to a location of your choice.

   → Tip
   In case of the downloaded archive has the same name as the former archive, you can add the major and minor version to the name of the downloaded archive. So that you do not need to replace the former archive. This enables you to revert the update if it is required.

2. Configure the new archive as an update site.
   a. In the menu bar, select [Windows > Preferences].
   b. In the Preferences window, select the [Install/Update > Available Software Sites].
   c. To add the new archive, select the [Add... > Archive...] button to specify the location and enter a name for your local software site.

3. Trigger the update by selecting the menu entry [Help > Check for Updates].

6.3 Recommendations for the System Administrator

The Installation Steps [page 27] above describe how to install all front-end components that are required to run ABAP Development Tools (ADT) on a local machine.

In addition, SAP system administrators or IT experts can build their own Eclipse IDE package, containing ADT. This package can be distributed to the ABAP developers using a standard distribution process.

Example

If ABAP developers in your company, have no permission to install ADT on their local machines, this option enables you to build Eclipse IDE packages containing ADT which can be distributed using the distribution process of your company.

To create the Eclipse IDE package for central distribution, you have the following options:
• **Manual Building of a Distributable Eclipse IDE Package [page 34]:** You want to define the configuration and creation of your Eclipse IDE package step-by-step.

• **Automated Building of a Distributable Eclipse IDE Package [page 36]:** You want to automate the configuration and creation of your Eclipse IDE package.

• **Updating an Already Distributed Eclipse IDE Package [page 43]:** You want to update an Eclipse IDE package which has already been distributed within your company.

### 6.3.1 Manual Building of a Distributable Eclipse IDE Package

You want to build an Eclipse IDE package, that is based on an existing Eclipse IDE package and contains ABAP Development Tools features, step-by-step. This package can then be centrally distributed within your company.

#### Prerequisites

Download and extract an Eclipse IDE package (for example, Eclipse IDE for Java Developers) or install an SAP HANA Studio. Herein, install the ADT features as described above [page 27].

The Eclipse IDE that has been previously installed needs to be closed.

|i Note|
---|
To avoid unexpected behavior of the Eclipse IDE, do not work in folders that require specific write authorizations on your local machine. Such a folder would be, for example, *Program Files* on Microsoft Windows™.

#### Context

You want to manually prepare an Eclipse IDE package step-by-step for central distribution within your company.

→ **Recommendation**

SAP recommends to use manual building before you start using the automated option [page 36].

#### Procedure

1. Navigate to the directory where you have extracted the Eclipse IDE package and have installed the ADT features.
2. Configure the default values for various preferences as follows:
a. Open the `eclipse.ini` file with a text editor.

b. After the `--launcher.appendVmargs` statement, ...

**i Note**

To ensure that user-specific configuration data is **not** overwritten with the next update, define the configuration area and the location of the instance area (workspace) explicitly.

For more information, see:
- [Eclipse Multi-User Installs](#)
- [The Eclipse runtime options](#)

1. Define the configuration area.

   **Sample Code**

   ```
   -configuration
   @user.home\AppData\Local\ADT\configuration
   ```

2. Define the instance area.

   **Sample Code**

   ```
   -data
   @user.home\AppData\Local\ADT\workspace
   ```

c. Save your changes.

3. [Optional:] Configure a default proxy as follows:

   To define the proxy configuration of the Eclipse IDE using a configuration file, proceed as follows:

   a. Navigate to the directory where you have extracted the Eclipse IDE package and have installed the ADT features.
   
   b. Open the `eclipse.ini` file with a text editor.
   
   c. At the beginning of the file, insert the following code snippet:

   **Source Code**

   ```
   -pluginCustomization
   plugin_customization.ini
   ```

d. Save your changes.

e. Create a new file named `plugin_customization.ini` with a text editor and save it in the same folder as the `eclipse.ini` file.

f. Insert the following code snippet:

   **Source Code**

   ```
   org.eclipse.core.net/proxyData/HTTP/host=<your_proxy_host>
   org.eclipse.core.net/proxyData/HTTP/port=<your_proxy_port>
   org.eclipse.core.net/proxyData/HTTPS/host=<your_proxy_host>
   org.eclipse.core.net/proxyData/HTTPS/port=<your_proxy_port>
   org.eclipse.core.net/systemProxiesEnabled=false
   ```
g. Add the values for the proxy host and proxy port.

h. Save your changes.

Note
If there are no folders upon restart of the Eclipse IDE, preconfigured folders are used or created.

4. Provide the Eclipse IDE package to your IT organization for distribution.

Results

You have manually created a preconfigured Eclipse IDE package, that contains ADT features.

This package can, for example, be compressed, and centrally distributed to ABAP developers through the distribution process of your company.

Note
ABAP developers can change the predefined configuration in the preferences of the Eclipse IDE. These changes are stored in their instance area or configuration area. Consequently, these preferences are not overwritten with the next update.

Related Information

Prerequisites [page 24]
Automated Building of a Distributable Eclipse IDE Package [page 36]

6.3.2 Automated Building of a Distributable Eclipse IDE Package

You want to build an Eclipse IDE package, that is based on an existing Eclipse IDE package and contains ABAP Development Tools features, in an automated way, using an Ant script. This package can then be centrally distributed within your company.

Prerequisites

• Download and extract an Eclipse IDE package (for example, Eclipse IDE for Java Developers) from http://www.eclipse.org or install an SAP HANA Studio.
To ensure that the added features will be located inside the Eclipse IDE package, do not work in folders that require specific write authorizations on your local machine. Such a folder would be, for example, Program Files on Microsoft Windows™.

For more information, see Eclipse multi-user installs.

* Download the ADT package from the SAP Software Download Center on the SAP Support Portal.

**Context**

You want to centrally distribute an Eclipse IDE package containing ABAP Development Tools in an automated way within your company.

To run an Ant script, you need an Ant Runner, that is included in any Eclipse IDE package.

Execution of the Ant script automatically accepts all questions regarding licensing, without further notification or information! It also triggers the installation of all the required Eclipse features [page 25].

The steps of the subsequent procedure are only relevant for Windows™.

**Procedure**

You can define your own Ant script step-by-step or use a sample code [page 53] and adopt it.

To develop your own Ant script, proceed as follows:

1. Create a file named installSAPtools.xml with a text editor in the location of your choice.

   * **Note**
     You can reuse this script for upcoming releases.

2. Insert the following code snippet:

   `<project name="<your_project_name>" default="install">
   <target name="install">
   <!-- Insert your code here -->
   </target>
   </project>`

3. Within the `target` element, define the properties to declare the Eclipse IDE release you work with as well as the repositories from which you retrieve the required Eclipse features and ADT features that need to be installed as follows:
   a. Specify the release of the used Eclipse IDE.
Add the property element and the following attributes and values:

- **name** with the value `eclipse.release`
- **value** with the name of the Eclipse release, for example `2022-06`.

### Note
The value of properties can be reused using the `${<property_name>}` placeholder.

#### Sample Code
```
<property name="eclipse.release" value="2022-06"/>
```

b. Configure the repositories that are used for downloading the Eclipse and ADT features.

Add another property element and the following attributes and values:

- **name** with the value `repo`
- **value** with the URLs of the Eclipse update site and the file location of the downloaded ADT package

### Note
You can add several values. Use commas to separate them.

#### Sample Code
```
<property name="repo" value="jar:file:/C:/<ADT package>!/,http://download.eclipse.org/releases/${eclipse.release}/"/>
```

c. Configure the installable units of Eclipse (in short “iusRequiredEclipseFeatures”) to define which Eclipse features are to be installed from the Eclipse update site by your Ant script.

Add the property element and the following attributes and values:

- **name** with the value `iusRequiredEclipseFeatures`
- **value** with the feature ID of the Eclipse feature

For more information, see Eclipse features [page 25].

#### Sample Code
```
Sample code snippet that contains the feature IDs required for ADT:

<property name="iusRequiredEclipseFeatures" value="org.eclipse.emf.databinding.edit.feature.group,
org.eclipse.emf.query.feature.group,
org.eclipse.emf.workspace.feature.group,
org.eclipse.emf.validation.feature.group,
org.eclipse.graphiti.feature.feature.group,
org.eclipse.wst.ws_ui.feature.feature.group,
org.eclipse.zest.feature.group"/>
```

d. Configure the installable units of ADT (in short “iusADT”) to define which ADT features are to be installed by your Ant script.
Add the `property` element and the following attributes and values:

- `name` with the value `iusADT`
- `value` with the name of the relevant ADT feature groups

**Sample Code**

Sample code snippet that contains the plug-in IDs of the ADT features:

```xml
<property name="iusADT" value="com.sap.adt.tools.bopf.feature.group, 
com.sap.adt.pitools.tlf.feature.group, 
com.sap.adt.core.feature.group, 
com.sap.adt.tools.hana.feature.group, 
com.sap.adt.wda.core.feature.group"/>
```

**Note**

You can add several values. Use commas to separate them.

The following table provides you an overview of the feature IDs and ADT features to be installed:

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>com.sap.adt.tools.bopf.feature.group</code></td>
<td>ABAP Business Object Tools</td>
</tr>
<tr>
<td><code>com.sap.adt.pitools.tlf.feature.group</code></td>
<td>ABAP Enterprise Services And Integration Development Tools</td>
</tr>
<tr>
<td><code>com.sap.adt.core.feature.group</code></td>
<td>ABAP Core Development Tools</td>
</tr>
<tr>
<td><code>com.sap.adt.tools.hana.feature.group</code></td>
<td>ABAP Development Tools for SAP HANA</td>
</tr>
<tr>
<td><code>com.sap.adt.wda.core.feature.group</code></td>
<td>ABAP Development Tools for Web Dynpro</td>
</tr>
</tbody>
</table>

4. Within the `target` element, define how to run the installation of the Eclipse and ADT features by adding the following code snippet:

For more information, see [Installing software using the p2 director application](#).
5. [Optional:] If you want to set certain preferences, such as proxy settings, add the `propertyfile` element within the target element and define access for default values of various preferences.

**Note**
ABAP developers can change the preferences at any time. These changes are stored in their instance area or configuration area. Preferences that are changed in the `plugin_customization.ini` are considered with a lower priority.

a. To make the script generate the `plugin_customization.ini`, add the following code snippet:

```xml
<propertyfile file="./plugin_customization.ini">
  <entry key="org.eclipse.core.net/proxyData/HTTP/host" value="<proxy_host/>
  <entry key="org.eclipse.core.net/proxyData/HTTP/port" value="<proxy_port/>
  <entry key="org.eclipse.core.net/proxyData/HTTPS/host" value="<proxy_host/>
  <entry key="org.eclipse.core.net/proxyData/HTTPS/port" value="<proxy_port/>
  <entry key="org.eclipse.core.net/systemProxiesEnabled" value="false"/>
  <entry key="org.eclipse.equinox.p2.ui.sdk.scheduler/enabled" value="false"/>
</propertyfile>
```

The following table provides you an overview of the preferences to be enabled or disabled:

<table>
<thead>
<tr>
<th>Key</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>org.eclipse.core.net/systemProxiesEnabled</td>
<td>true|false</td>
<td>Enables/disables the usage of the proxy settings, that are defined by the operating system</td>
</tr>
<tr>
<td>org.eclipse.equinox.p2.ui.sdk.scheduler/enabled</td>
<td>true|false</td>
<td>Enables/disables automatic check for updates on startup of the Eclipse IDE</td>
</tr>
</tbody>
</table>

6. Define the location of the instance area (workspace) and configuration area as follows:

a. Within the target element, add the `replace` element and add the following code snippet:

**Note**
The `replace` element defines how to search, replace, and add content within the `eclipse.ini` file. If the content to be replaced cannot be found, execution is terminated with an error.

In SAP HANA Studio, the file with the content to be replaced is named `hdbstudio.ini`. 
The `<replace>` element defines the value to be replaced. The `<replacevalue>` element defines the new value to be added.

```xml
<replace file="./eclipse.ini" failOnNoReplacements="true">
  <replacetoken>--launcher.appendVmargs</replacetoken>
  <replacevalue>--launcher.appendVmargs
    -configuration @user.home\AppData\Local\ADT\configuration
    -data @user.home\AppData\Local\ADT\workspace
    -pluginCustomization plugin_customization.ini
  </replacevalue>
</replace>
```

b. Within the `<replacevalue>` element, define the location of the instance area and configuration area as well as the reference for the defined `plugin_customization.ini` file.

**Note**

To ensure that user-specific configuration data is not overwritten with the next update, define the configuration path and the location of the installation area (workspace) explicitly.

For more information, see:

- [Eclipse Multi-User Installs](#)
- [The Eclipse runtime options](#)

- Define the folder to be used as configuration area.

```
-configuration @user.home\AppData\Local\ADT\configuration
```

- Define the folder to be used as an instance area.

```
-data @user.home\AppData\Local\ADT\workspace
```

- If you have defined a `plugin_customization.ini` file, define the path to the corresponding `plugin_customization.ini` file.

```
-pluginCustomization plugin_customization.ini
```

7. After the `<replace>` element, add the following code snippet to remove all update sites from the distributable Eclipse IDE package.
8. Manually copy the `installSAPtools.xml` file containing the Ant script into the same directory where you have downloaded and prepared the Eclipse IDE package.

9. Open a new command line and navigate to the directory of the Eclipse IDE package.

10. Execute the Ant script by triggering it from the command line.

```
<fileset dir="./p2/org.eclipse.equinox.p2.engine/profileRegistry"
  includes="**/*.repositoryprefs" />
```

Results

The command starts the Eclipse Ant runner, that uses the script to create a preconfigured Eclipse IDE package, that contains the ADT features.

This package can, for example, be compressed, and centrally distributed to ABAP developers through the distribution process of your company.

→ Recommendation

SAP recommends to create a copy of the newly created Eclipse IDE package for testing the result of the script before distribution. Otherwise, any user-specific or workspace-specific settings might become part of the distributed package.

Related Information

- Updating an Already Distributed Eclipse IDE Package [page 43]
- Apache Ant™ Manual
- Installation Steps [page 27]
- Prerequisites [page 24]
- Disclaimer [page 6]
6.3.3 Updating an Already Distributed Eclipse IDE Package

Prerequisites

As a system administrator, you have already generated and distributed an Eclipse IDE package containing ADT within your company.

Your IT organization has to remove the former Eclipse IDE package before installing a new one.

Note

Do not delete the instance area (workspace) or configuration area. Keep their folders and names consistent. Otherwise, ABAP developers might lose their preferences or workspace.

The location and name of the Eclipse IDE package itself can vary.

Context

You want to update to a newer ADT version or Eclipse release that has already been distributed.

Procedure

1. Download and extract the newest version of the
   • Eclipse IDE package (for example, Eclipse IDE for Java Developers) or install an SAP HANA Studio.
   • ADT package from the SAP Support portal.
2. Depending on your choice, proceed as follows:
   • For manual building, follow the steps described in chapter Manual Building of a Distributable Eclipse IDE Package [page 34], and continue with step 4.
   • For automated building, adjust the `eclipse.release` attribute and the corresponding repositories in your Ant script.
3. Rerun the Ant script.
4. Delete the former installation and distribute the new Eclipse IDE package.

Note

If the configuration area and instance area (workspace) are set to a path within the Eclipse IDE package directory, you will lose user-specific configuration data [page 35].

Results

The updated Eclipse IDE package is available to your ABAP developers.
ABAP Development Tools runs on the latest version.

**Related Information**

Automated Building of a Distributable Eclipse IDE Package [page 36]
7  Post-Installation

7.1  [Optional] Home Configuring SAP GUI for Java

Context

If you are using SAP GUI for Java, ensure that the qualified paths are defined for the configuration files in the preferences of SAP GUI for Java.

In addition, you can use the following VM parameters in the eclipse.ini file to configure the installation path of SAP GUI for Java:

<table>
<thead>
<tr>
<th>VM Parameter</th>
<th>Default Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>com.sap.adt.sapgui.javaGuiInstallationPath</td>
<td>null</td>
<td>Installation path of the SAP GUI for Java in order to specify the location in case if it is not automatically detected</td>
</tr>
</tbody>
</table>

Procedure

In the Eclipse installation folder, open the eclipse.ini file.

At the end of the existing command lines, add the support-relevant VM parameters starting with "-D".

\[ i \text{ Note} \]

Add the specific value after the equal mark at the end of the VM parameter.

\[ i \text{ Example} \]

The following example is taken from a macOS installation:

\[-Dcom.sap.adt.sapgui.javaGuiInstallationPath=/Applications/SAP Clients/SAPGUI 7.70/\]
7.2 [Optional] Configuring VM Parameters

![Home](icon.png)

Support-Relevant VM Parameters

In case of a support issue, you can provide additional information to SAP support. You will then might be asked to define the following VM parameters in the `eclipse.ini` file:

<table>
<thead>
<tr>
<th>VM Parameter</th>
<th>Default Value</th>
<th>Description</th>
</tr>
</thead>
</table>
| com.sap.adt.sapgui.winguiTraceLevel=<n> | 0             | Setting in order to switch the GUI trace (DTRACE) to the given level if Java GUI is not installed in the default folder. The following settings are available in order to activate the GUI trace:  
  - Level 1: Errors: Only the errors are documented in the debug trace file.  
  - Level 2: See level 1 plus warnings are documented in the debug trace file.  
  - Level 3: A diagnose is started that writes all information in the debug trace file when an embedded trace file is started. |
| sapguiconfig.trace.level=<value> | 0             | Trace level that is used while parsing the SAP UI landscape configuration file using the SAPGUIConfig library. The following values can be set to define the data to be traced while parsing:  
  - 0: Tracing is off  
  - 1: URLs that are loaded while instantiation  
  - 2: plus details how the SAP UI landscape configuration data is loaded  
  - 3: plus the content of the SAP UI landscape configuration data is dumped  
  - 4: plus all details about internal parsing steps, for example, resolving of the message servers, and so on |

**Note**

The higher the value the more data is traced.

For further information, see the Frontend Installation Guide (Microsoft Windows™) on SAP GUI Community.
<table>
<thead>
<tr>
<th>VM Parameter</th>
<th>Default Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sapguiconfig.trace.file=&lt;full_path&gt;</td>
<td>&lt;workspace&gt;.metadata.plugins.com.sap.adt.sapgui.config.sapguiconfig.log</td>
<td>Full path of the trace file for the SAPGUIConfig library</td>
</tr>
<tr>
<td>com.sap.adt.sapgui.ui.win32.pipeConnectionTimeout=&lt;time_m s&gt;</td>
<td>30.000</td>
<td>Timeout in ms in order to affect the SAP GUI startup process (sapguiserver.exe)</td>
</tr>
<tr>
<td>com.sap.adt.destinations.model.landscape.parser.official=&lt;value&gt;</td>
<td>true</td>
<td>Setting to define which parser is used for parsing the landscape configuration file for SAP GUI integration. If true, the SAP GUI parser is used. Otherwise, the ADT proprietary parser is used.</td>
</tr>
</tbody>
</table>

**i Note**
You can also add these parameters to your Ant script for automated building [page 40] of an Eclipse IDE package.

**General Procedure**

1. In the Eclipse installation folder, search and open the `eclipse.ini` file.
2. At the end of the existing command lines, add the VM parameter starting with "-D".
   
   **i Note**
   Add the specific value after the equal mark at the end of the VM parameter.
3. Save your changes.
4. Restart your IDE.
   
The IDE is restarted and the VM parameters are effective now.

**Example**

- **Home** In the following example, the timeout for the SAP GUI startup process is defined with 60,000 ms:

  ```
  -Dcom.sap.adt.sapgui.winguiTraceLevel=1
  -Dcom.sap.adt.sapgui.ui.win32.pipeConnectionTimeout=60000
  ```

- **Example**

  - **Cloud** This is how the VM parameter entry in the `eclipse.ini` for enabling a cloud pilot project looks like:

    ```
    -Dcom.sap.adt.tools.cloud.authentication.ui.cloud.pilot.project=true
    ```
7.3  [Optional] Configuring Accessibility Features of ADT

Eclipse and ABAP Development Tools (ADT) offer various accessibility features for use with a screen reader, such as bigger fonts, higher contrasts, for example. Some of these features are active by default; some have to be configured.

Procedure

To find more information, open the SAP - ABAP Development User Guide > Concepts > Accessibility Features in ADT Help Contents in your Eclipse-based IDE.
8 De-Installation

Context

To uninstall all front-end components required for running ABAP Development Tools, proceed as follows:

Procedure

1. To uninstall the ABAP Development Tools package, proceed as follows ...
   a. Launch your Eclipse IDE – if this has not already been done.
   b. Choose the menu Help ➤ About…
   c. Click the Installation Details button.
   d. Select the corresponding nodes, such as ABAP Core Development Tools, etc.
   e. Click the Uninstall… button.

   ![Uninstall Details](image)

   The Uninstall Details page displays a list of feature groups that will be uninstalled.
   f. To start the uninstall process, choose Finish.
2. [Optional-] If you have installed the Microsoft Visual C++ Runtime manually, you need to remove it.

Microsoft Visual C++ 2013 Redistributable
(x64) - 12.0.40660

20.6 MB

11.04.2019

12.0.40660.0

Modify  Uninstall

Related Information

Support Platform Matrix [page 17]
9 Support Case

9.1 Providing Additional Information for Analyzing an Error

The Trace Configuration enables you to provide SAP additional information in case of errors in locations such as Debugger, Coverage, ABAP source code, etc.

Context

You set the Trace Configuration in the Preferences depending on the error location, proceed as follows:

Procedure

1. In the Eclipse workbench, choose the menu Window > Preferences.
2. In the Preferences window, select ABAP Development > Trace Configuration.
3. In the Level list box, choose Info.
4. In the Location area, open the ABAP Development Tools tree and choose the corresponding entry, for example, Profiler > UI.
5. Confirm with OK.

Results

Now, the Eclipse-based IDE traces additional information which you can collect and provide as a ZIP file to the SAP support.

i Note

Only enable the Tracing Configuration in case of a specific error. Because, tracing is intense in memory consumption, deselect all locations after creating the support information file. Otherwise your client might work slower or after the next restart of the client, a corresponding dialog is opened.

Related Information

Getting Support Information [page 52]
9.2 Getting Support Information

Context

Should errors occur in connection with ABAP Development Tools for which you, as an SAP customer, require more detailed support from SAP, it is of considerable importance that you provide all the required data for such a support case in order to speed up the troubleshooting process. For this purpose, ABAP Development Tools provides a comfortable tool support solution. With a few simple mouse clicks, you can generate a support information file. This file contains all the relevant data for your IDE or GUI version, as well as information on preference settings and technical system environment data. You can then add this support file to your OSS problem message as an attachment.

To collect the support information, proceed as follows:

Procedure

1. In the Eclipse workbench, choose the menu Help Collect Support Information...

![Image of menu selection]

Launching the Support Information Collection using the menu

2. In the dialog box that appears, specify the location of the support file and choose Finish.
10 Additional Information

10.1 Installing Plug-ins from Third Parties

Your installation of Eclipse can be enriched with additional plug-ins from various providers (so called third party plug-ins) alongside ABAP Development Tools (ADT).

Risks

These plug-ins can gain control over your client installation or even your complete front-end PC.

Protection Measures

You should carefully decide on plug-ins that you are going to install. For this, only use plug-ins from trusted sources and which are using signatures.

→ Recommendation

If you do not trust third party plug-ins for Eclipse in general, we recommend managing this via your corporate requirements.

10.2 Sample Code for Building an Ant Script

The following sample code can be used as an example how to develop an Ant script for automated building of a distributable Eclipse IDE package.

i Note

To make the sample code executable, you need to adopt the relevant placeholders and the name of used elements.

|= Sample Code |

```
<project name="<prepareEclipse>" default="install">
  <target name="install">
    <property name="eclipse.release" value="<eclipse_release>">
    <property name="repo" value="jar:file:/C:/<ADT package>!/,http://download.eclipse.org/releases/${eclipse.release}/" />
  </target>
</project>
```
<property name="iusRequiredEclipseFeatures" value="org.eclipse.emf.databinding.edit.feature.group,
org.eclipse.emf.query.feature.group,
org.eclipse.emf.workspace.feature.group,
org.eclipse.emf.validation.feature.group,
org.eclipse.graphiti.feature.feature.group,
org.eclipse.wst.ws_ui.feature.feature.group,
org.eclipse.zest.feature.group"/>
<property name="iusADT" value="com.sap.adt.tools.bopf.feature.group,
com.sap.adt.pitools.tlf.feature.group,
com.sap.adt.core.feature.group,
com.sap.adt.tools.hana.feature.group,com.sap.adt.wda.core.feature.group"/>
<java class="org.eclipse.equinox.launcher.Main"
failonerror="true">
<classpath>
<fileset dir="plugins">
<include name="org.eclipse.equinox.launcher_*.jar"/>
</fileset>
</classpath>
<arg value="-application"/>
<arg value="-repository"/>
<arg value="-${repo}"/>
<arg value="-installIU"/>
<arg value="${iusRequiredEclipseFeatures}"/>
<arg value="-installIU"/>
<arg value="${iusADT}"/>
</java>
<propertyfile file="./plugin_customization.ini">
<entry key="org.eclipse.core.net/proxyData/HTTP/host" value="${proxy_host}"/>
<entry key="org.eclipse.core.net/proxyData/HTTP/port" value="${proxy_port}"/>
<entry key="org.eclipse.core.net/proxyData/HTTPS/host" value="${proxy_host}"/>
<entry key="org.eclipse.core.net/proxyData/HTTPS/port" value="${proxy_port}"/>
<entry key="org.eclipse.core.net/systemProxiesEnabled" value="false"/>
</propertyfile>
<replace file="./eclipse.ini" failOnNoReplacements="true">
<replacetoken>--launcher.appendVmargs</replacetoken>
<replacevalue>--launcher.appendVmargs
-configuration
${user.home}\AppData\Local\ADT\configuration
-data
${user.home}\AppData\Local\ADT\workspace
-pluginCustomization
plugin_customization.ini
</replacevalue>
</replace>
<delete>
<fileset dir="./p2/org.eclipse.equinox.p2.engine/profileRegistry"
includes="**/*.repository.prefs"/>
</delete>
</target>
</project>

Related Information

Additional Information [page 53]
Important Disclaimers and Legal Information

Hyperlinks

Some links are classified by an icon and/or a mouseover text. These links provide additional information.

About the icons:

- Links with the icon 🌐: You are entering a Web site that is not hosted by SAP. By using such links, you agree (unless expressly stated otherwise in your agreements with SAP) to this:
  - The content of the linked-to site is not SAP documentation. You may not infer any product claims against SAP based on this information.
  - SAP does not agree or disagree with the content on the linked-to site, nor does SAP warrant the availability and correctness. SAP shall not be liable for any damages caused by the use of such content unless damages have been caused by SAP’s gross negligence or willful misconduct.
- Links with the icon 🔗: You are leaving the documentation for that particular SAP product or service and are entering an SAP-hosted Web site. By using such links, you agree that (unless expressly stated otherwise in your agreements with SAP) you may not infer any product claims against SAP based on this information.

Videos Hosted on External Platforms

Some videos may point to third-party video hosting platforms. SAP cannot guarantee the future availability of videos stored on these platforms. Furthermore, any advertisements or other content hosted on these platforms (for example, suggested videos or by navigating to other videos hosted on the same site), are not within the control or responsibility of SAP.

Beta and Other Experimental Features

Experimental features are not part of the officially delivered scope that SAP guarantees for future releases. This means that experimental features may be changed by SAP at any time for any reason without notice. Experimental features are not for productive use. You may not demonstrate, test, examine, evaluate or otherwise use the experimental features in a live operating environment or with data that has not been sufficiently backed up.

The purpose of experimental features is to get feedback early on, allowing customers and partners to influence the future product accordingly. By providing your feedback (e.g. in the SAP Community), you accept that intellectual property rights of the contributions or derivative works shall remain the exclusive property of SAP.

Example Code

Any software coding and/or code snippets are examples. They are not for productive use. The example code is only intended to better explain and visualize the syntax and phrasing rules. SAP does not warrant the correctness and completeness of the example code. SAP shall not be liable for errors or damages caused by the use of example code unless damages have been caused by SAP’s gross negligence or willful misconduct.

Bias-Free Language

SAP supports a culture of diversity and inclusion. Whenever possible, we use unbiased language in our documentation to refer to people of all cultures, ethnicities, genders, and abilities.